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Please read this guide, including all Precautions, before using this label printer. After reading this guide, keep it in
a safe place.
For FAQs, Troubleshooting, and to download the label printer’s software and manuals, visit support.brother.com

Category Details

Tape Cassette Type Brother TZe Tape Cassette

Compatible Widths 3.5 mm, 6 mm, 9 mm, 12 mm, 18 mm, 24 mm

Tape Widths (Inches) 0.13 in., 0.23 in., 0.35 in., 0.47 in., 0.70 in., 0.94 in.

Head Cleaning Tape Cassette TZe-CL4

Rechargeable Battery PA-BT-005

Note:

Brother reserves the right to make changes without notice in the specifications and materials contained herein

and shall not be responsible for any damages (including consequential) caused by reliance on the materials

presented, including but not limited to typographical and other errors relating to the publications.

Unauthorized duplication or reproduction of any or all content of this document is prohibited.

Please note that we cannot assume any responsibility for any damage or lost profit arising from the use of the

label created with this label printer or the disappearance or change of data due to failure, repair or

consumables using battery, or any claim from a third party.

http://support.brother.com


Precautions

Safety Precautions
Follow these guidelines to avoid the risk of heat generation, smoking, explosion, fire, or injury.
DANGER Failure to observe instructions and warnings will result in death or serious injuries.
Rechargeable Li-ion Battery

Do not allow the battery to come into contact with liquids.

Do not charge, use, or leave the battery in high temperature (above 60 °C (140 °F)) locations.

Use the included USB cable to charge.

Use the battery only for its intended purpose.

Keep the battery away from heat and fire.

Do not connect the + and – terminals with metal objects such as wire. Do not carry or store the battery with

metal objects.

Do not throw, hit or damage the battery in any way.

Do not solder any connections to the battery.

Do not disassemble or modify the battery.

Do not dispose of the battery with household waste.

ARNING Failure to observe instructions and warnings could result in death or serious injuries.

Rechargeable Li-ion Battery

Keep the battery away from infants. If the battery is ingested, seek immediate medical advice.

Stop using the battery if there are noticeable abnormalities such as smell, heat, deformities, or discoloration.

If liquid from the battery gets into your eyes, wash them with clean water and see a doctor immediately.

Label Printer and USB Cable

Use the included USB cable to prevent any damage.

Do not use during a thunderstorm.

Do not damage.

Do not place heavy objects on.

Do not forcibly bend or pull.

Do not disassemble or modify.

Do not drop or hit.

Do not allow to come into contact with liquids.

If you notice abnormalities such as smell, heat generation, discoloration, or deformation while in use or storage,

stop using the label printer, disconnect the USB cable, and remove the battery.

When the label printer is not being used, store it out of the reach of children. In addition, do not allow children to

put any label printer parts or labels in their mouths. If ingested, seek immediate medical advice.

CAUTION Failure to observe instructions and wamings could result in minor or moderate injuries.

Rechargeable Li-ion Battery

If liquid from the battery gets onto skin or clothes, immediately rinse them with water. Label Printer and USB



Cable

Use the dedicated battery (PA-BT-005).

When opening and closing the Cassette Cover, use caution to prevent your fingers from being trapped.

Do not touch the Print Head.

Do not touch the cutter blade or insert your fingers inside the Tape Exit Slot.

General Precautions

Label Printer, Tape Cassette, or USB Cable

Do not use in any way or for any purpose not described in this guide. Doing so may result in accidents or

damage.

Use Brother 129 Tape Cassettes.

Do not put any foreign objects into the Tape Exit Slot, the USB Port, the battery compartment, etc.

do not place in any location exposed to extremely high or low temperatures, high humidity, or dust, such as

direct sunlight, rain, near heaters, other hot appliances, on the dashboard, or in the back of your car.

Do not try to print if the cassette is empty; it will damage the Print Head.

Do not pull the tape while printing or feeding; it will damage the tape and the label printer.

The length of a printed label may differ from the displayed label length.

Depending on the location, material, and environmental conditions, labels may unpeel or become irremovable,

or the color may change or be transferred to other objects. Before applying labels, check the environmental

conditions and the material.

When printing multiple copies of a label, the label printer will not detect the end of the tape cassette and will

continue printing.

Printed characters may look different than previewed, as your device’s or computer’s screen may have a higher

resolution than the label printer.

Printed small text may not be as clear as it is displayed.

White and gold-printed objects may not always print clearly.

The backing of some types of tapes may be pre-cut to make it easier to peel the backing. To remove the

backing, simply fold the label lengthwise with the text facing inward to expose the inside edges of the backing.

Next, peel off the backing one piece at a time.

Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily from

these surfaces.

For rough and textured surfaces, we recommend using Extra Strength Adhesive Tape.

Be sure to read the instructions provided with Fabric Tapes, Extra Strength Adhesive Tapes, or other special

tapes and observe all precautions noted in the instructions.

Set Up Your Label Printer

Parts Description

Insert the Tape Cassette

1. Place your fingers on the Tape Exit Slot.

2. Open the Cassette Cover by pulling the Tape Exit Slot to the left.



3. Confirm that the tape is pointed at the Tape Exit Slot and gently press the Tape Cassette into the label printer

until it locks into place.

Make sure that there is no slack in the tape. To fix any slack, pull the end of the tape out of the Tape

Guide.

When inserting or removing the Tape Cassette, make sure that the tape does not catch on the label

printer.

4. Close the Cassette Cover.

Charge the Battery

1. Pull out the protective sheet (first time only).

2. Connect the label printer to the computer using the included USB cable, or connect the USB cable to a USB AC

Adapter suitable for charging mobile devices, and plug the adapter into a power source. Charge until the

Battery LED turns off.

Note:

Use the included USB cable.



If charging the battery using a computer, make sure the computer is on.

Notes on Using the Rechargeable Li-ion Battery

1. Charge the battery in environments between 10 and 35 °C (50 and 95 °F), otherwise the battery will not charge,

and the Battery LED will remain lit.

2. If the label printer is used to print, feed, or perform another operation while charging, charging may stop even

though the battery is not fully charged. Charging resumes when the operation is completed.

Rechargeable Li-ion Battery Characteristics

To ensure the highest performance and longest life from the rechargeable Li-ion Battery, when storing the label
printer for a long period:

1. Charge once every six months.

2. Store in a cool dry place out of direct sunlight, between 10 and 35 °C (50 and 95 °F).

Remove Battery for Replacement or Disposal

1. Turn the label printer off.

2. Open the Cassette Cover.



3. Remove the two screws from the Battery Cover using a flat-bladed screwdriver.

4. Remove the battery.

Note:

Dispose of batteries at an appropriate collection point. Be sure to observe all applicable local regulations.

When storing or discarding a battery, cover the contacts with cellophane tape to prevent it from short-

circuiting.

DANGER

Do not dispose of the battery with household waste.

There is a risk of environmental damage, explosion, or fire.

5. When reinserting the battery, make sure the battery’s contacts are touching the contacts inside the battery

compartment.

6. Replace the Battery Cover, reinsert the screws, and tighten them with a flat-bladed screwdriver.

7. Close the Cassette Cover.

Turn the Power On or Off

Action Instructions

Power On Press the Power Button.

Power Off Press and hold the Power Button until the Power LED turns off.

Print from Your Mobile Device

Download the P-touch apps from the App Store or Google Play™.



App Name Description

iPrint&Label

Create labels for business use, including barcodes, office equipment labels, and labels f
or folder tabs.

P-touch Design&Pri
nt 2

Design and create stylish labels for work or home, offering a variety of design options
and templates.

Press the Power Button twice quickly to feed and cut the tape.

Before each initial print, the label printer feeds approximately 25 mm (1 in.) of blank tape.

Pair the Label Printer with Your Mobile Device

On your mobile device:

1. Go to the settings menu and make sure the Bluetooth® option is on.

2. Select PT-P710B** (where *** is the last four digits of your label printer’s serial number. The unit’s serial number

is located inside the Cassette Cover, underneath the TZe Tape Cassette.).



Note:

1. If asked to enter a PIN Code, enter “0000”.

2. Pairing instructions may differ slightly, depending on your mobile device.

3. If your label printer is not found by your mobile device, your label printer may already be connected to another

device. If so, turn off Bluetooth on that device, or turn your label printer off and then on again.

4. This label printer does not support Wi-Fi connections.

5. If your label printer is not found on your mobile device, make sure the label printer is not in sleep mode.

Visit install. brother and install the printer driver and P-touch Editor by following the on-screen instructions.

Software Features

Printer Driver Required for printing from a label printer.

P-touch Editor Label creation software for computers. Includes drawing tools for creating custom labels with 
various fonts, styles, frames, images, and barcodes.

P-touch Updat
e Software Updates applications to the latest version.

Printer Setting 
Tool Configures settings for the label printer.

You can visit support.brother.com to update the P-touch Editor for Mac and access additional support resources.

Windows

Create Labels with P-touch Editor

1. Connect the label printer and your computer with the included USB cable.

2. Double-click the P-touch Editor icon  on the desktop.

3. Create a new layout or open an existing layout.

4. Select the mode as necessary:

Option Function

Auto Cut Cuts each label automatically, ensuring neat and consistent labels without manual intervention.

Chain Printi
ng Allows you to save tape by not cutting the last label, enabling continuous label printing.

Special Tap
e

Feeds tape for manual cutting, ideal for special tapes such as Fabric Tapes and Extra Strength A
dhesive Tapes.

Mirror Printi
ng Prints in reverse, are useful for creating labels that will be viewed through transparent surfaces.

Note:

http://install.brother
https://support.brother.com


Press the Power Button twice quickly to feed and cut the tape.

Before each initial print, the label printer feeds approximately 25 mm (1 in.) of blank tape.

The Cable Labeling Wizard allows you to create layouts for electrical equipment management.

This label printer does not support Bluetooth connections for computers.

When printing from your computer, you must connect the label printer and computer with the included USB

cable.

This label printer does not support Wi-Fi connections.

To select the layout

Double-click the layout icon.

Select the layout icon, then click the arrow mark →.

To change the P-touch Editor startup settings

Click the Tools menu, and select > Options.

In the Options window, select General and select the startup setting you want from Operations.

Configure Settings Using the Printer Setting Tool

1. Connect the label printer and your computer with the included USB cable.

2. Start the Printer Setting Tool.

Operating Syste

m

Versio

n
How to Start

Windows 7 7 Start > All Programs > Brother > Label & Mobile Printer > Printer Setting Tool

Windows 8 8 Apps > Printer Setting Tool

Windows 8.1 8.1 Start > Brother > Printer Setting Tool

Windows 10 10 Start > Brother > Printer Setting Tool

3. Click Device Settings.

The following settings can be changed:



Setting Description

Auto Power On
Configure whether the label printer automatically turns on when it is connected to a USB 

AC adapter or a computer.

Auto Power Off
Set the period of time before the label printer automatically turns off when it is connected t

o a USB AC adapter or a computer.

Auto Power Off 

(Li-ion)

Set the period of time before the label printer automatically turns off when using the recha

rgeable Li-ion battery.

Contents Configure the label printer information that will be printed.

Length

Adjustment

Adjust the length of the printed label to match the length of the label displayed on the com

puter.

 

4. Click Apply > Exit.

5. Click Exit in the main window.

Note:

Check that the label printer you want to configure appears next to the Printer. If a different label printer appears,

select your label printer from the drop-down list.

Do not perform another job while changing the settings.

Apply Settings Changes to Multiple Label Printers

1. After applying settings to the first label printer, disconnect the label printer from the computer.

2. Connect the second label printer to the computer.

3. Select the newly connected label printer from the Printer drop-down list.

4. Click Apply.

Repeat steps 1 to 4 for all label printers whose settings you want to change.

Note:

To save the current settings in a file, click File > Export.

The same settings can be applied to other label printers. Click File > Import, then select the exported file.

Update Software

1. Double-click the P-touch Update Software icon on the desktop.



2. Click the Computer software update icon .

3. Select the Printer and Language, select the check boxes next to the software you want to update, and then

click Install.

Close all other Brother applications.

Update Firmware

1. Turn on the label printer, and connect it to your computer with the included USB cable.

2. Double-click the P-touch Update Software icon  on the desktop.

3. Click the Machine update icon  .

4. Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.

5. Select the Language, select the check boxes next to the firmware you want to update to, and then click

Transfer.

6. Click Start.

Note:

1. Do not power off or disconnect the USB cable while updating.

2. Close all other Brother applications.

Mac

Create Labels with P-touch Editor

1. Connect the label printer and your computer with the included USB cable.

2. click Macintosh HD > Applications > P-touch Editor.

3. Select a new template or a template category.

Note:

1. Press the Power Button twice quickly to feed and cut the tape.

2. Before each initial print, the label printer feeds approximately 25 mm (1 in.) of blank tape.

3. This label printer does not support Bluetooth connections for computers.

4. When printing from your computer, you must connect the label printer and computer with the included USB

cable.

5. This label printer does not support Wi-Fi connections.

Configure Settings Using the Printer Setting Tool

1. Connect the label printer and your computer with the included USB cable.

2. Click Macintosh HD > Applications > Brother > Printer Setting Tool > Printer Setting Tool.



3. Select any of the Settings tabs, and then configure the settings.

4. Click Apply Settings to the Printer.

5. Click Exit.

Note:

1. Check that the label printer you want to configure appears next to the Printer. If a different label printer appears,

select the label printer from the drop-down list.

2. Do not perform another job while changing the settings.

Apply Settings Changes to Multiple Label Printers

1. after applying settings to the first label printer, disconnect the label printer from the computer.

2. Connect the second label printer to the computer.

3. Select the newly connected label printer from the Printer drop-down list.

4. Click Apply Settings to the Printer.

Repeat step 1 to 2for all label printers whose settings you want to change.

Note:

1. To save the current settings in a file, click Export.

2. The same settings can be applied to other label printers. Click Import, then select the exported file.

Setting Description

Auto Power On Configures whether the label printer turns on automatically when connected to a USB AC a
dapter or a computer.

Auto Power Off Sets the period of time before the label printer turns off automatically when connected to a 
USB AC adapter or a computer.

Auto Power Off (
Li-ion)

Sets the period of time before the label printer turns off automatically when using the rechar
geable Li-ion battery.

Length Adjustm
ent Adjusts the length of the printed label to match the length displayed on the computer.

Update Firmware

1. Turn on the label printer, and connect it to your computer with the included USB cable.

2. Click Macintosh HD > Applications > P-touch Update Software.

3. Click Machine update.

4. Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.

5. Select the Language, select the check boxes next to the firmware you want to update to, and then click

Transfer.

6. Click Start.



Note:

1. Do not power off or disconnect the USB cable while updating.

2. Close all other Brother applications.

Appendix

Maintenance
Before performing any maintenance, disconnect the USB cable and power off the label printer.
Clean the Label Printer Exterior
Wipe the label printer’s exterior with a soft, dry cloth to remove dirt or dust. If the label printer is heavily soiled,
wipe it with a cloth dampened with some water.
Do not use solvents or agents such as benzene, paint thinner, or alcohol, which may damage the label printer’s
surface.
Clean the Print Head
Streaks or poor-quality characters on printed labels generally indicate that the print head is dirty.
You can use either the optional dedicated Head Cleaning Tape Cassette (TZe-CL4) or a cotton swab to gently
wipe dirt from the Print Head.

Note:

Put the Head Cleaning Tape Cassette in the label printer, and press the Power Button twice quickly.

Approximately 25 mm (1 in.) of tape feeds each cleaning cycle. If the problem is not solved after repeating this

process three times, contact Brother customer service.

CAUTION
Do not touch the Print Head. You may get burned.

Clean the Tape Cutter
Tape adhesive can build up on the cutter blade after repeated use, taking the edge off the blade which may result
in the tape jamming in the cutter. Wipe the cutter blades using a cotton swab moistened with ethanol or isopropyl
alcohol.
CAUTION
Do not touch or insert your fingers into the cutter blade.



Troubleshooting

LED Color Condition Power LED Status

Green Bluetooth connection established Lit

Orange Feeding or cutting tape Lit

Orange Printing Lit

Orange Receiving data from a mobile device or computer Flashing (0.5 second intervals)

Orange Transferring program Lit for 3 seconds, then off

Orange Standby Lit

Orange Initializing Flashing (0.5 second intervals)

Orange Cooling Flashing (0.5 second intervals)

LED Indications



Battery LED Status Condition Description

Orange, Lit Fully charged The battery is fully charged.

Orange, Flashing (0.5 seco
nd intervals) Charging The battery is currently charging.

Not lit for 3 seconds, then 
lit for 0.5 seconds

Only half the battery 
charge remains The battery is about half-charged.

Not lit for 2 seconds, then 
flashing twice

The battery charge is
low The battery needs to be recharged soon.

Flashing (0.5 second inter
vals)

Insufficient charge or 
battery failure

The battery may be faulty or need recharging. Refer to tr
oubleshooting for further assistance.

LED Troubleshooting

Power LED Stat
us Condition How to Clear an Error

Flashing Battery fail
ure Replace the battery if the problem persists.

Flashing twice 
per second, the
n off for 1
second

No Tape Ca
ssette instal
led
Incorrect Ta
pe
Cassette in
stalled
Incompatibl
e Tape Cas
sette install
ed

Insert the correct Tape Cassette. Lightly press the Power Button. Ensure the p
rotective sheet is removed.

Flashing (1 sec
ond intervals)

Insufficient 
charge Charge the battery. Wait for the Power LED to turn green before trying again.

Red, Flashing

High-tempe
rature error
Transmissio
n error
Cutter error
Program tr
ansfer failur
e

When using a mobile device, establish a Bluetooth connection. Restart the lab
el printer. When using a computer, reconnect the USB cable, change the USB 
port, and restart the label printer. Transfer the program again.

Lit System err
or

Contact Brother customer service. The flashing pattern may change if you tou
ch the Power Button.



If you need additional help, visit support.brother.com

Problem Solution

The label printer does not print.

– Check that the Tape Cassette is inserted correctly.
– Replace the Tape Cassette if it is empty.
– Ensure the Cassette Cover is securely closed.
– Verify that the charge is not low.
– Ensure the label printer is turned on.
– Check that the mobile device is not in sleep mode.
– Confirm that Bluetooth is enabled on the mobile device.
– Make sure the label printer is connected to your mobile device
via Bluetooth.
– Ensure the label printer is selected in the P-touch app.
– Verify that the label printer is not paired with another device.
– Ensure the label printer and mobile device are close enough.
– Avoid interference from devices emitting radio waves.
– Install the correct printer driver when printing from a computer.
– Connect the label printer to your computer using the included 
USB cable.
– Check that the label is not blank.

The tape does not feed correctly.

– If the tape is bent, cut off the bent section.
– Remove the Tape Cassette, pull out any jammed tape, and cut
it.
– Ensure the tape is aligned properly with the Tape Guide.
– Confirm that the tape is correctly positioned at the Tape Exit Sl
ot.
– Reinsert the tape cassette.

The tape gets stuck inside the label printe
r.

– Confirm that the end of the tape is correctly aligned with the T
ape Guide.
– Check that the tape is pointed toward the Tape Exit Slot.
– Remove and reinsert the Tape Cassette.

A tape jam error cannot be cleared
despite troubleshooting. – Contact Brother customer service for further assistance.

A horizontal gap runs through the middle 
of the printed label.

– Streaks or poor quality prints usually indicate a dirty Print Hea
d.
– Clean the Print Head according to the maintenance instruction
s.

An error occurred when using a mobile ap
p.

– Go to your mobile app’s settings menu > Support page > FAQ
s & Troubleshooting for help.

I want to cancel the current printing job. – Ensure the label printer is on and lightly press the Power butto
n.

If the ink ribbon is broken. – Replace the Tape Cassette.

Product Specifications

http://support.brother.com


Specification Details

Dimensions Approximately 128 mm (W) x 67 mm (D) x 128 mm (H) / 5 in. (W) x 2.6 in. (D) x 5 in. (
H)

Weight (with battery) Approximately 640 g

Operating Temperatur
e 10 to 35 °C (50 to 95 °F)

Operating Humidity 20 to 80% (without condensation)

Interface – Label Printer Side: USB 2.0 Full Speed (for Windows/Mac)
– Bluetooth Version: 2.1+EDR Class2

Trademarks
Mac and Macintosh are trademarks of Apple Inc.
App Store is a service mark of Apple Inc.
Google Play is a trademark of Google LLC.
The Bluetooth ® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of
such marks by Brother Industries, Ltd. is under license.
Wi-Fi is a registered trademark of Wi-Fi Alliance®.
Any trade names and product names of companies appearing on Brother products, related documents and any
other materials are all trademarks or registered trademarks of those respective companies. QR Code is a
registered trademark of DENSO WAVE INCORPORATED.

FAQs

What is the Brother PT-P710BT P-Touch Cube Plus?

The Brother PT-P710BT P-Touch Cube Plus is a compact label maker that connects via Bluetooth to your
smartphone or tablet, allowing you to create and print high-quality labels.

The Brother PT-P710BT P-Touch Cube Plus connects to devic

The Brother PT-P710BT P-Touch Cube Plus connects to devices via Bluetooth, making it easy to design
and print labels from your smartphone or tablet.

What is the print resolution of the Brother PT-P710BT P-Touch Cube Plus?

The Brother PT-P710BT P-Touch Cube Plus offers a print resolution of 180 dpi, ensuring clear and sharp
label text.

What label widths can the Brother PT-P710BT P-Touch Cube Plus handle?



The Brother PT-P710BT P-Touch Cube Plus supports label widths ranging from 3.5mm to 24mm.

What types of labels can the Brother PT-P710BT P-Touch Cube Plus print?

The Brother PT-P710BT P-Touch Cube Plus can print various types of labels, including address labels,
file folder labels, and organizational labels.

What accessories come with the Brother PT-P710BT P-Touch Cube Plus?

The Brother PT-P710BT P-Touch Cube Plus package includes the label maker, AC adapter, rechargeable
battery, a starter tape, and a USB cable.

How do you design labels with the Brother PT-P710BT P-Touch Cube Plus?

Labels are designed using the Brother P-Touch Design&Print app, which can be downloaded on iOS and
Android devices.

What is the maximum label length that the Brother PT-P710BT P-Touch Cube Plus can print?

The Brother PT-P710BT P-Touch Cube Plus can print labels up to approximately 13.1 feet long with the
included starter tape.

What is the weight of the Brother PT-P710BT P-Touch Cube Plus?

The Brother PT-P710BT P-Touch Cube Plus weighs approximately 1.0 lbs (0.45 kg).

How long does the rechargeable battery of the Brother PT-P710BT P-Touch Cube Plus last?

The battery life of the Brother PT-P710BT P-Touch Cube Plus varies depending on usage but generally
provides several hours of printing.



Can the Brother PT-P710BT P-Touch Cube Plus be used without a smartphone or tablet?

The Brother PT-P710BT P-Touch Cube Plus is primarily designed for use with the Brother P-Touch
Design&Print app, so it relies on a smartphone or tablet for label design and printing.

What type of print technology does the Brother PT-P710BT P-Touch Cube Plus use?

The Brother PT-P710BT P-Touch Cube Plus uses thermal transfer print technology to produce durable
and long-lasting labels.

Video- Brother PT-P710BT P-Touch Cube Plus Label Maker

Download this Manual: Brother PT-P710BT P-Touch Cube Plus Label Maker User Guide
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